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摘要 

本研究在了解不同植物受傷時是否會發出超聲波，及超聲波頻率是否會有差異，我們

將被子植物莖切斷後，使用自製超聲波感測器接收植物在受到傷害後發出的超聲波數據進行

分析。實驗結果發現，植物在受到切斷這類的物理傷害時，會間斷地發出60分貝以上的超聲

波。單雙子葉植物不同的維管束排列，並不影響植物發聲的狀況，而是跟植物種類的個體構

造差異有關，維管束的數量越多，發出超聲波的次數也越多；維管束面積比例越高、發出的

超聲波頻率也越高。最後我們推論植物超聲波的產生，主要是維管束切斷時導致水分運輸速

度不同而產生的水錘效應，及木質部斷面水分蒸發產生的空氣柱有關。這樣的超聲波可能對

周圍的植物產生警示並進而調節生理機制。 

壹、前言 

一、研究動機 

生物課時，老師曾提過一篇研究，內容是植物在壓力下會發出尖叫聲，但這個尖

叫聲是人耳聽不到的超聲波，植物的聲音透過空氣傳播並提供訊息，這顛覆我們一般

對植物安靜的認知。所以我們想確認植物是不是真的會發出超聲波？只有報告上有的

植物才會發出聲音嗎？也想知道不同種類的植物發出的聲音狀況是否一樣。 

二、研究目的 

(一)各種類植物維管束數量及面積比例之分析 

(二)比較單子葉植物與雙子葉植物在受傷狀態下發出的超聲波差異 

(三)在受傷狀態下，探討維管束數量和植物發出超聲波的關係 

(四)在受傷狀態下，探討維管束在莖內比例和植物發出超聲波的關係 

(五)在有無照光下，植物受到傷害所發出的超聲波差異 

三、文獻探討 

根據 Itzhak Khait 和 Ohad Lewin-Epstein (2023) 在科學期刊中發表的一篇研究，提到

植物在環境壓力下會發出超聲波，透過空氣傳播並提供訊息。作者使用了番茄、玉米、

小麥和葡萄等植物當作實驗材料，發現這些植物在乾旱和切割的狀況下都會發出超聲

波，推測可能是因為莖中的維管束發生了空蝕現象，讓空氣產生振動而發出聲音。 
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貳、研究設備及器材 

一、實驗植物 

我們選擇了文獻中提到的番茄(雙子葉植物)與玉米(單子葉植物)來做實驗，因為生

長期較短、也較容易取得。後來更進一步尋找校園中不同種類的植物進行實驗，以收集

更多數據進行比對。 

(一)單子葉植物 

玉米 

Zea mays 

鯽魚草 

Eragrostis amabilis 

狗牙根 

Cynodon dactylon 

吊竹梅 

Tradescantia zebrina 

鼠尾粟 

Sporobolus fertilis 

 

(二)雙子葉植物 

番茄 

Solanum lycopersicum 

繁星花 

Pentas lanceolata 

大花咸豐草 

Bidens pilosa 

美洲假蓬 

Conyza bonariensis 

馬拉巴栗 

Pachira aquatica 

 

二、實驗器材 

超聲波感測器TCT40 OPA350PA運算放大器 電阻(1、3.9、10、200k𝛺) 

鋁質電解電容10𝜇f / 25V PCB板 Arduino Uno 

解剖刀 支撐架 酒精溫度計 

刀片 紙箱 吸音棉 

100cm鐵尺 螺旋測微器 複式顯微鏡 

超聲波感測器HC-SR04 鏟子 燈泡(10W 1055lm) 

TWINTEX TFG-3200E系列 

DDS雙輸出數位信號產生器 

壓電超聲波喇叭 

(MEETOOT) 
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三、實驗裝置圖 

(一)為了隔絕外界的聲音干擾，我們設計了一個隔音箱，內部貼滿能有效隔絕聲音的隔

音棉，箱子內部如下圖。 

 

(圖 2-3-1) 植物切斷前 

 

(圖 2-3-2) 植物切斷後 

(三)這是我們的超聲波感測器電路圖，裝置使用的最高電壓為5V，超聲波感測器TCT40

會將接收到的訊號傳給OPA350PA運算放大器後再傳給 Arduino Uno ，裝置圖如下。

 

(圖 2-3-3) 超聲波接收器 

 

(圖 2-3-4)超聲波接收器電路圖 
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參、研究過程或方法 

一、前置操作 

(一)選擇實驗用植物 

1.生長期較短、也較容易取得與種植的植物：玉米、番茄 

2.國中生物課植物實驗中較常用的植物：吊竹梅、繁星花 

3.校園中的單子葉草本植物：鼠尾粟、狗牙根、鯽魚草 

4.校園中的雙子葉草本植物：大花咸豐草、美洲假蓬 

5.校園中的木本植物：馬拉巴栗 

(二)種植實驗用植物 

本次選用種植的植物共有四種： 

1.玉米(禾本科) 

2.番茄(茄科) 

3.吊竹梅(鴨跖草科) 

4.繁星花(茜草科) 

將植物種植在實驗室陽台的花盆中，平日每天澆水一次。用來實驗的植物需長到一定

高度，例如番茄和玉米的標準是20cm，因為這個高度的番茄莖不會太軟、太細而容易

折斷，玉米則是葉長在莖的較上方位置，實驗過程中不會切到葉，且莖也能較完整的

保留。 

(三)製作接收器 

1.將超音波感測器TCT40、OPA350PA、電容、電阻及電線焊接在PCB板上(圖 2-3-5) 

2.以杜邦線連接 PCB 板與 Arduino Uno 

3.將 Arduino Uno 連接上電腦 

4.用支撐架固定PCB板 

5.編寫偵測超聲波用 Arduino 程式碼 

(四)裝置測試 

1.將裝置連接到電腦上，上傳程式到Arduino Uno上 

2.將數位信號產生器連接喇叭後發出的固定音頻的超聲波(30kHz、40kHz、50kHz)，再

以接收器接收，由電腦上的讀值確定感測器能正常運作 
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(五)測量隔音箱的隔音效果 

1.使用手機app分貝計分別測量隔音箱內和隔音箱外音量大小數值。 

2.進行數據比較，分析實驗裝置的隔音效果。 

二、實驗步驟及研究方法 

(一)實驗一、比較不同植物在受傷狀態下的超聲波差異 

1.將植物放入隔音箱 

2.用溫度計測量當時室溫 (℃) 

3.用鐵尺測量植物當時高度 (cm) 

4.測量完好時的聲音 

(1)測量隔音箱內植物在尚未切斷的狀況下是否有發出超聲波(約10分鐘) 

5.切斷植物 

(1)將植物的莖靠近感測器的收音孔，找到預備下刀位置 

(2)用解剖刀將植物的莖從預備位置橫向切斷  

6.紀錄從切下植物到發出聲音的時間 (秒) 

7.用螺旋測微器測量植物莖的直徑 (mm) 

8.等待10分鐘看是否有持續發出超音波 

9.觀察植物維管束排列 

(二)實驗二、比較不同植物在受傷狀態下的音波差異 

1.將植物放入隔音箱 

2.用溫度計測量當時隔音箱內溫度 (℃) 

3.用鐵尺測量植物當時高度 (cm) 

4.測量植物完好時的聲音 

測量隔音箱內植物在尚未切斷的狀況下是否有發出超聲波(約10分鐘) 

5.切斷植物 

(1)將植物的莖靠近感測器的收音孔，找到預備下刀位置 

(2)用解剖刀將植物的莖從預備位置橫向切斷  

6.紀錄從切下植物到發出聲音的時間 (秒) 

7.用螺旋測微器測量植物莖的直徑 (mm) 

8.等待10分鐘看是否有持續發出超音波 

9.觀察植物維管束排列 
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(三)實驗三、在受傷狀態下，探討維管束數量和植物發出超聲波的關係 

1.將植物的莖切成薄片 

2.用複式顯微鏡觀察維管束的排列 

3.將複式顯微鏡下的植物莖切片拍照 

4.計算植物維管束數量 

(四)實驗四、在受傷狀態下，探討維管束比例和植物發出超聲波的關係 

1.用 ImageJ 程式計算維管束面積和莖的截面積 

 

(1)打開 ImageJ 

(2)點 File → Open →  開照片

(3)點 Analyze → Set Scale 設定比例 

(4)點 Image → Type → 8-bit 

(5)點 Image → Crop 

(6)點 Image → Adjust → Threshold 

(7)點 Analyze → Analyze Particles 

2.計算植物的維管束比例 

                   維管束面積 ÷ 莖總截面積 × 100%= 維管束比例% 
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(五)實驗五、比較在有無照光下，植物受到傷害時所發出的超聲波差異 

1.在隔音箱內部裝上燈泡 (10W 1055lm) 

2.用溫度計測量當時隔音箱內溫度 (℃) 

3.用鐵尺測量植物當時高度 (cm) 

4.將植物放入隔音箱中 

(1)開燈24小時(加強蒸散作用)或關燈24小時(減弱蒸散作用) 

5.使用超聲波接收器測量植物發出的超聲波 

6.紀錄從切下植物到發出聲音的時間 (秒) 

7.用螺旋測微器測量植物莖的直徑 (mm) 

三、數據統計分析方法 

(一)相關性分析(R)：R值代表相關程度之高低，在正負0.3之間 (0.3至-0.3之間) 稱為低度

相關；在正負0.3至0.6之間 (介於0.3至0.6，-0.3至-0.6之間) 稱為中度相關；而在正負

0.6至0.9之間 (在0.6至0.9，-0.6至-0.9之間) 則稱為高度相關；若是R值為正負 1，表

示完全相關。  

(二)t檢定：t檢定中，t值是統計檢定的結果，P值是在分佈常態分佈下 ≥ t值的機率密度

值，t值越接近0，兩組之間越沒有差異，t值越遠離 0則兩組差異越大。 
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肆、研究結果 

前置實驗、裝置測試 

(一)超聲波收音裝置的測試 

 1.我們想用自製超聲波接收器接收數位信號產生器連接喇叭發出的超聲波來進行準

確率的測試，但一開始卻沒辦法收到數據，經調整信號產生器數次後，才發現是

因為聲波的振幅太小無法接，因此我們想先了解自製超聲波接收器可接收的最小

分貝為何。我們分別給喇叭2V和4V的輸出電壓值，而輸出電壓越大，表示產生的

聲波振幅越大。接著再用手機內建的分貝計，測試不同頻率下發出的音量以及感

測器能收到的音量範圍。 

頻率(kHz) 

2V輸出 4V輸出 

最低分貝(dB) 最高分貝(dB) 最低分貝(dB) 最高分貝(dB) 

5 55 58 53 62 

10 55 58 54 60 

15 57 61 58 66 

20 54 59 55 61 

(表4-0-1)2V及4V聲波分貝比較 

由上表可知，輸出電壓為2V時的音量最大值皆小於60分貝，而4V時可達60分貝以

上，表示我們的自製超聲波接收器可接收的超聲波音量範圍限制在60分貝以上。 
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 2 .接著進一步確認此自製接收器所接收到的數據是否準確，我們用接收器接收喇叭

發出的固定音頻(30kHz、40kHz、50kHz)的聲音，每0.5秒接收一個數據測試15秒，

資料結果如下： 

 

由圖表可知，在30、40、50kHz的連續音頻下，自製超聲波接受器都可以接收到相對

應的數值，雖然數值有些上下浮動（誤差值約±10kHz），但準確率分別有達86.7%、7

3.3%、76.7%，表示我們自製接收器的數據與實際接收到的超聲波音頻相符合。 

 

(二)隔音箱測試 

我們為了測試隔音箱的隔音效果，分別在隔音箱內外測量分貝數，測試結果如下表： 

 隔音箱內 隔音箱外 

分貝(dB) 33.5 44.5 

(表4-0-2 分貝測試結果) 

由上表可知隔音箱可以有效的隔絕部分環境雜音，而且隔音箱內外部的聲音都未達60

分貝，未達自製超聲波接收器可接收的音量範圍，不會影響我們的實驗結果。 
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實驗一、各種類植物維管束數量及面積比例之分析 

我們將各種類的植物以實驗裝置收集超聲波數據，再把實驗植物的莖切成薄片用顯微鏡

觀察，再用 ImageJ 進行維管束比例分析，實驗結果如下表。 

植物

類型 

植物名稱 植物學名 莖切片照片 倍率 維管束平

均數量 

(個) 

莖面積和維管

束面積比例 

雙 

子 

葉 

植 

物 

美洲假蓬 Conyza  

bonariensis 

 

40 34 20.10% 

大花 

咸豐草 

Bidens pilosa 

 

40 16 35.89% 

番茄 Solanum  

lycopersicum 

 

40 8.3 26.92% 

繁星花 Pentas lanceolata 

 

40 20 

 

10.49% 

馬拉巴栗 Pachira aquatica 

 

40 86 23.56% 

(表 4-1-1)雙子葉植物維管束數量及面積比例數據 
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植物 

類型 

植物名稱 植物學名 照片 倍率 維管束平

均數量

(個) 

莖面積和維管

束面積比例  

單 

子 

葉 

植 

物 

玉米 Zea mays 

 

40 

 

94 26.89% 

狗牙根 Cynodon dactylon 

 

40 13 28.32% 

鼠尾粟 Sporobolus fertilis 

 

40 44 38.75% 

鯽魚草 Eragrostis 

amabilis 

 

40 20 22.88% 

吊竹梅 Tradescantia  

zebrina 

 

40 28.6 10.50% 

(表 4-1-2)單子葉植物維管束數量及面積比例數據 
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實驗二、比較單子葉植物與雙子葉植物在受傷狀態下發出的超聲波差異 

實驗二-1 各類植物有發聲的實驗次數與比例 

(一) 單子葉植物的發聲比例 

植物種類 玉米 鼠尾粟 鯽魚草 狗牙根 吊竹梅 

實驗次數 10 5 10 8 21 

發聲次數 6 4 5 7 6 

發聲比例 60% 80% 50% 87.5% 28.6% 

(表 4-2-1)單子葉植物的發聲比例 

(二) 雙子葉植物的發聲比例 

植物種類 番茄 繁星花 美洲野蓬 大花咸豐草 馬拉巴栗 

實驗次數 19 7 4 5 6 

發聲次數 6 2 2 4 2 

發聲比例 31.6% 28.6% 50% 80% 33.3% 

(表 4-2-2)雙子葉植物的發聲比例 

由結果可知，單子葉植物除了吊竹梅，其餘種類普遍發聲比例都超過50%，雙子葉植

物則相反，大部分發聲比例小於50%。我們從有發聲的實驗進行後續聲音頻率、發出

多次聲音的實驗次數、起始發聲時間.....等分析。  
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實驗二-2 比較不同植物發出超聲波的平均頻率 

 

(圖 4-2-1) 不同種類植物(單、雙子葉)的平均頻率比較 

由上圖可觀察到發出最高頻率的是鼠尾粟，其次是大花咸豐草，第三高的是吊竹梅，

平均頻率最低的則是馬拉巴栗。 

接著比較單、雙子葉植物的平均頻率如下圖： 

 

(圖 4-2-2) 單、雙子葉植物的平均頻率比較 

由上圖可知單子葉植物的平均頻率略高於雙子葉植物，但在進行統計t檢定後，p值為

0.14無顯著差異。 
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實驗二-3 探討不同植物發出多次超聲波的比例 

我們接著要探討植物發出超聲波的次數差異，我們計算植物發出2個以上超聲波的實

驗次數除以總實驗次數並進行比較，結果如下圖： 

 

(圖 4-2-3) 不同種類植物發出多個超聲波次數的比例比較 

由上圖可以發現單子葉植物的玉米和鼠尾栗，每次實驗發出多個超聲波的比例較高，

幾乎每兩次實驗就有一次發出多個聲音，而各種雙子葉植物發出兩個以上超聲波的比

例都偏低。 

 

 

(圖 4-2-4) 單、雙子葉植物發出多個超聲波實驗次數比例比較 

接著比較單、雙子葉植物在發出兩次以上聲音的實驗次數比例，單子葉植物高於雙子

葉植物，但在進行統計t檢定後，p值為0.16未達顯著差異。 
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實驗二-4 比較各種植物的起始發聲時間 

我們接著分析各類植物從切斷到發出聲音的時間的概況，將玉米(單子葉)和番茄(雙子

葉)的每次實驗的發聲起始時間做成散佈圖如下：

 

(圖 4-2-5) 玉米發出第一個超聲波的時間 

 

(圖 4-2-6) 番茄發出第一個超聲波的時間

由上圖可明顯看到玉米發出聲音的起始時間差異較大，最短切斷1秒後即發出聲音，

最長需到13秒，番茄發出聲音的起始時間則平均都在4秒以內。 

接著將各種實驗植物從切斷到發出聲音的時間數據，整理成下圖： 

 

(圖 4-2-7) 不同種類植物的平均持續發聲時間比較 

由上圖可觀察到從切斷到第一次發出聲音，需要較長時間的種類為美洲假蓬，其次

是鼠尾粟，然後是玉米，需要最短時間的則是繁星花。 
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將單、雙子葉植物從切斷到發出聲音的時間取平均進行比較如下圖： 

 

(圖 4-2-8) 單、雙子葉植物平均發出超聲波時間比較 

可從結果看到單子葉植物從切斷到發出聲音的時間多於雙子葉植物約1秒，但進行統

計t檢定後，得到p值為0.46，無顯著差異。 

實驗三、在受傷狀態下，探討維管束數量和植物發出超聲波的關係 

實驗三-1 探討植物發出超聲波的頻率和維管束數量關係 

將超聲波頻率與維管束數量做相關分析整理成下圖： 

  

(圖 4-3-1) 植物發出超聲波頻率與維管束數量關係 

由上圖可看到維管束數量多寡並不影響發出的超聲波頻率，統計分析後得相關係數

為-0.07，屬於低度相關。 
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實驗三-2 探討植物發出超聲波的次數和維管束數量關係 

接著將切斷植物後連續發出的超聲波次數與維管束數量做相關分析整理成下圖： 

  

(圖 4-3-2) 植物發出超聲波次數與維管束數量關係 

由圖中的數據分佈，可觀察到維管束數量越少，單次實驗發出超音波的次數也越

少，反之亦然，進行統計分析後，得到相關係數為0.927，屬於高度正相關。 

實驗三-3 探討植物的起始發聲時間和維管束數量關係 

我們測量植物的起始發聲時間並與維管束數量做相關分析整理成下圖：  

 

(圖 4-3-3) 植物發出超聲波的時間與微管束數量關係 

由上圖可知維管束數量在40個以內時，植物發出超聲波的起始時間有達8秒以上，也

有短於2秒，因此我們認為維管束數量與超聲波的起始時間的關聯性不大，進行統計

分析後，得到相關係數為0.482，屬於中度相關。 
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實驗四、在受傷狀態下，探討維管束在莖內比例和植物發出超聲波的關係 

實驗四-1 探討維管束比例和植物發出的超聲波頻率關係 

我們計算各種植物的維管束面積比例並與超聲波頻率做相關分析整理成下圖： 

 

(圖 4-4-1) 植物發出的超聲波頻率與維管束比例關係 

由上圖可知，維管束比例越高時，植物發出超聲波的頻率也越高，反之亦然，進行

統計分析後，得到相關係數為0.817，屬於高度正相關。 

實驗四-2 探討維管束比例和植物發聲次數的關係 

我們將植物發聲次數與各種植物的維管束比例做相關分析整理成下圖： 

  

(圖 4-4-2) 植物發出超聲波的次數與維管束比例關係 

由圖可看出維管束比例與植物發出超聲波次數並無規律性的關係，統計分析後得相

關係數為0.197，屬於低度相關。 
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實驗四-3 探討維管束比例和植物起始發聲時間的關係 

我們將各種植物的維管束比例和植物發聲的起始時間做相關分析後整理成下圖。 

(圖 4-4-3)  維管束比例與植物發出超聲波時間的關係 

由上圖可以發現植物維管束的比例不會影響植物發出超聲波的時間，進行統計分析

後，得到相關係數為0.219，屬於低度相關。 

實驗五、在有無照光下，植物受到傷害所發出的超聲波差異 

我們初步推論植物在切斷時，因中斷水分的輸送導致木質部發出聲音，為了進一步驗

證此想法，因此設計了實驗五來探討水分運輸速率對發聲是否會造成差異，我們分為

照光組和黑暗組。我們將照光與黑暗組在實驗中總發聲次數整理如下表： 

實驗五-1 玉米和繁星花在有無照光時的發聲總次數 

 
植物 

玉米 (單子葉) 繁星花 (雙子葉) 

照光 黑暗 照光 黑暗 

實驗次數 3 3 3 3 

總發聲次數 28 23 4 2 

(表 4-5-1)玉米和繁星花在有無照光時的發聲總次數 

由上表可發現不管是玉米(單子葉)或繁星花(雙子葉)，照光組的發聲總次數皆多於黑暗

組。 
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實驗五-2 植物在有無照光時的聲音頻率差異 

 

(圖4-5-1) 玉米在照光和黑暗時的超聲波頻率比較 

我們計算玉米在有無照光時發出超聲波的平均頻率並做成圖表，由上圖可知玉米在

照光時的聲音頻率較黑暗低，相差約1.7kHz，進行統計t檢定後，p值為0.37未達顯著

差異。 

 

 

(圖4-5-2) 繁星花在照光和黑暗時的超聲波頻率比較 

我們計算繁星花在有無照光時發出超聲波的平均頻率並做成圖表，由上圖可知繁星

花在有照光時頻率較處於黑暗時低，相差約6kHz，進行統計t檢定後，p值為0.003有

顯著差異。 
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實驗五-3 植物在有無照光時的發聲時間差異 

 

(圖4-5-3) 玉米在照光和黑暗時的發聲時間比較 

我們計算玉米在有無照光時發出超聲波的平均時間並做成圖表，由上圖可知玉米在

照光時的發聲時間較黑暗時短，進行統計t檢定後，p值為0.14未達顯著差異。 

 

(圖4-5-4) 繁星花在照光和黑暗時的發聲時間比較 

我們計算繁星花在有無照光時發出超聲波的平均時間並做成圖表，由上圖可知繁星

花在照光時發聲時間較黑暗時長，進行統計t檢定後，p值為0.17未達顯著差異。 
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實驗五-4 玉米單次實驗中的發聲頻率概況分析 

我們進一步想要探討照光時發聲頻率較黑暗時低的原因，所以我們將實驗數據做整理

後如下圖：

 

(圖 4-5-5) 玉米照光時的超聲波頻率               

 

(圖 4-5-6) 玉米在黑暗時的超聲波頻率

由上圖表可觀察到，玉米照光時的頻率範圍都在20~40kHz，而在黑暗時的頻率範圍大

多在20~40kHz，只有一個超聲波的頻率遠大於其他的超聲波，因此可知黑暗組的超聲

波頻率較高的原因是因為有單一的高頻聲音。 
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實驗五-5 所有植物的發聲頻率概況分析 

由實驗五-4的數據結果發現，我們想確認是否所有實驗的植物所收集到的發聲音頻都

有相似分布情形，因此我們拿實驗二~實驗四所有黑暗中所測得的聲音數據，來做進

一步的分析，以確認低頻(20 ~ 40KHz)與高頻(40KHz以上)超聲波的比例。 

 

頻率範圍(kHz) 玉米 鼠尾粟 鯽魚草 狗牙根 鴨跖草 

>60 3 4 0 2 0 

50~60 0 0 0 1 1 

40~50 6 1 1 0 1 

30~40 13 1 1 3 3 

20~30 31 5 5 4 3 

總實驗次數(有發聲) 11 4 6 7 6 

總發聲次數 53 11 7 10 8 

高頻超聲波比例(%) 16.98% 45.46% 14.29% 30% 25% 

(表4-5-2)單子葉植物發出不同頻率範圍的超聲波次數 

  (表4-5-3)雙子葉植物發出不同頻率範圍的超聲波次數 

由表4-5-2、4-5-3可知植物發出超聲波的頻率範圍大多在20~40kHz，只有部分超聲波頻

率範圍在40kHz以上。 

頻率範圍(kHz) 番茄 繁星花 美洲假蓬 大花咸豐草 馬拉巴栗 

>60 0 0 0 1 0 

50~60 1 0 0 2 0 

40~50 0 1 1 1 0 

30~40 2 2 2 1 1 

20~30 8 2 4 2 3 

總實驗次數(有發聲) 9 4 2 4 2 

總發聲次數 11 5 7 7 4 

高頻超聲波比例(%) 9.09% 20% 14.29% 57.14% 0% 
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伍、討論 

一、裝置的測試 

我們自製的超聲波接收器，經測試確認能有效地接收並顯示實際音頻的讀值，且接收的

音量限制約為60分貝以上，60分貝以下無法接收產生讀值。表示我們實驗中所接收到植

物所發出的超聲波，若以人耳能聽到的聲音來比較，屬於較大聲的音量，與文獻1中所

提到的植物發聲的大小約為60~70分貝的研究結果相符合。 

二、比較單、雙子葉植物在受傷狀態下的發聲差異 

我們原先假設單、雙子葉植物的維管束排列方式不同，對超聲波的發聲頻率與發聲時間

產生影響，但實驗後發現排列方式對超聲波產生並無關聯，而不同植物的結果存在種間

差異，推測是維管束的管徑差異造成影響。 

三、探討維管束數量和植物發出超聲波的關係 

實驗結果顯示植物維管束數量和發出超聲波的次數為高度正相關、與起始發聲時間是中

度相關、和發出的超聲波頻率高低無相關性，我們的推論如下： 

(一)我們推測超聲波的產生與木質部的水分運輸有關，因此維管束數量越多，發聲的

機率便隨之增加。 

(二)植物發出超聲波的起始時間應和維管束中的發聲效應有關，我們認為水分運輸的

快慢、管徑的大小等木質部的構造差異才是影響發聲時間的主要因素，與維管束

數量沒有直接的關聯性。 

(三)超聲波的頻率可能跟單一木質部的空間振動較有關，我們的分析結果與前述推論

是因維管束管徑大小不同而發出不同頻率的超聲波的說法吻合。 

四、探討維管束比例和植物發出超聲波的關係 

在實驗四中，維管束的比例與發聲頻率成高度正相關，鼠尾粟的維管束比例最高、發出

的平均聲音頻率也最高；而維管束比例較低的繁星花所發出的頻率平均也較低，其他植

物的情況也大致相符，推測是維管束產生發聲(水錘)效應時，植物莖內維管束的結構分

布及密度，會影響聲音頻率的高低，因此各類植物的發聲的頻率高低亦皆不同，但詳細

機制仍需進一步討論。 
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五、在有無照光下，受到傷害所發出的超聲波差異 

在同樣的實驗次數下，單、雙子葉的發聲次數皆為照光組多於黑暗組，此差異的原因是

植物在照光與黑暗的狀態下，影響了發聲的「水錘效應」。因為維管束中水分運輸較

快，水流衝撞管壁時容易發出振幅較大的音波(高於60分貝)，而被我們的自製超聲波接

收器收到訊號。 

接著分析照光組與黑暗組的發聲頻率，發現黑暗組聲波頻率較高，檢視單次實驗的原始

數據發現，一開始日照組和黑暗組的發生頻率差異不大，但黑暗組的植物發聲到後期，

會有單一較高頻的超聲波。我們推論當日照組植物，受到光照的調控氣打開，蒸散作用

旺盛，維管束中水分運輸較快，當植物被切斷時，快速運輸的水分突然被中斷，往前撞

擊水柱或管壁，發出多個較低頻的超聲波，而莖切斷面短時間內會有溢流的現象；黑暗

組亦會產生水錘效應，但差別在於氣孔關閉的狀況下，水分運輸慢，當植物被切斷時，

中斷的木質部不容易溢流，反而因為切斷面的水分蒸發，產生極短的空氣柱，因此產生

高頻的聲音，因此黑暗組的頻率高於照光組。 

再由實驗五-5數據分析看到，黑暗組植物發出單一較高頻超聲波的次數極少，所以推測

植物會發出超聲波主要因素還是水錘效應。

六、依據以上的推論，可以整理出植物在受到切斷此類的物理性傷害時，發出超聲波的可能

機制： 

(一)在維管束遭受切斷時，因管內流體被阻斷而產生水錘效應，產生一系列較低頻的超

聲波。 

(二)切斷面附近水分停留、甚至溢出，水錘效應持續發生。 

(三)後續在水分運輸中斷甚至水分蒸發的影響下，維管束斷面端產生空氣柱，由空氣柱

的振動產生駐波，進而發出較高頻超聲波。 

(四)空氣柱產生的音頻，決定於空氣柱的長度(相當於1/4波長)，因此切斷時的水柱蒸發

速率，與維管束的管徑皆會影響維管束內空氣柱的長度，進而影響發出超聲波的頻

率與次數。 
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(五)我們推論的發聲原理流程圖如下： 

 

(圖 5-6-1) 植物被切斷時發出超聲波的原理示意圖 

七、植物發聲的生物意義探討 

從以上的實驗中我們發現，植物在受到嚴重損傷及環境逆境(如缺水)時所發出超聲波，

是因物理現象所產生，而由文獻8、9的研究結果中發現，超聲波其實會影響植物的生理

現象，包括影響維管束內的運輸速率，以及使細胞內產生防禦性代謝物質和訊號傳導作

用等。因此我們推測植物在受到傷害後所發出的超聲波，對周圍植物會視為一種示警訊

號，幫助植物調節生理機制，以對應可能面臨的傷害與破壞。未來探究方向上，可進一

步再確認植物由逆境所產生的特定頻率超聲波，是否確實可以引起有效抵抗逆境的生理

反應，以確認我們的猜想。  
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陸、結論 

依照我們的實驗結果討論與分析，得到以下幾點結論： 

一、植物在受到切斷這類的物理傷害時，會間斷地發出60分貝以上的超聲波。 

二、單雙子葉維管束排列方式的差異不會影響植物發出超聲波，但是不同種類的植物存

在構造上的種間差異。 

三、總維管束數量只會影響發聲次數及聲量 (振幅) 大小，和植物發出超聲波的頻率高低

無關，推測植物發出的超聲波可能跟單一維管束內的空間振動較有關。 

四、植物的維管束數量越多，發出超聲波的次數也越多。 

五、植物的維管束比例越高，發出的超聲波頻率也越高。 

六、植物發聲的可能原因有二： 

1.水錘效應：莖的切斷導致水分運輸的拉力被中斷，但木質部裡下方的水流因為慣

性持續往前流動，衝撞前面水柱產生的壓力波，因而發出聲音。我們發現當維管

束水分運輸快時，衝撞產生的壓力波更明顯，植物容易發出次數多且較大的聲

音。 

2.當木質部中的水分運輸較慢時，切斷面的水分蒸發導致木質部中形成空氣柱，空

氣振動容易發出較高頻的超聲波。  



28 

柒、參考資料及其他 

1. Itzhak Khait & Ohad Lewin-Epstein (2023).Sounds emitted by plants under stress are airborne and infor

mative ,Cell,from:https://www.cell.com/cell/fulltext/S0092-8674%2823%2900262-3 

2.【獨立樣本t檢定(Independent Sample t test)-統計說明與SPSS操作】，永析統計及論文諮詢顧

問，取自:https://www.yongxi-stat.com/independent-sample-t-test/ 

3. t檢定，統計學知識入口網站，取自:https://www.jmp.com/zh_tw/statistics-knowledge-portal/t-test.h

tml 

4. 阿簡，以ImageJ測量葉面積，阿簡生物筆記，2007 年 9 月 1 日，取自:https://a-chien.blogspot.c

om/2007/09/imagej_2149.html 

5. Tommy Huang，統計學:大家都喜歡問的系列-p值是什麼，2018 年 2 月 14 日，Medium，取

自:https://reurl.cc/A4pRnQ 

6. 辛佳佑, 陳柏澄(2020)，驚聲尖叫—以台農二號木瓜探討植物接收超音波的反應及在不同逆

境中發出超音波的差異，金門地區第60屆中小學科展(第二名)，取自:https://science.km.edu.tw/ap

i/pageview/team/1085?t=1617005652 

7. 水錘作用，維基百科，取自:https://zh.wikipedia.org/zh-tw/%E6%B0%B4%E9%8C%98%E4%BD%

9C%E7%94%A8 

8. Mark E. Perel'man, Galina M. Rubinstein(2006).Ultrasound vibrations of plant cells membranes: water l

ift in trees, electrical phenomena,Cornell University,from:https://arxiv.org/abs/physics/0611133 

9. J.Wu&L.Lin,2002.Elicitor-like effects of low-energy ultrasound on plant (Panax ginseng) cells: inductio

n of plant defense responses and secondary metabolite production,springer link,from:https://link.springer.c

om/article/10.1007/s00253-002-0971-2 

 

【作品內圖表照片說明】 

本作品『莖聲尖叫–探討被子植物在受到傷害時的超聲波差異』內容所有照片、圖片、圖表

皆由作者自行拍攝、繪製。 

https://www.cell.com/cell/fulltext/S0092-8674%2823%2900262-3
https://www.yongxi-stat.com/independent-sample-t-test/
https://www.jmp.com/zh_tw/statistics-knowledge-portal/t-test.html
https://www.jmp.com/zh_tw/statistics-knowledge-portal/t-test.html
https://a-chien.blogspot.com/2007/09/imagej_2149.html
https://a-chien.blogspot.com/2007/09/imagej_2149.html
https://reurl.cc/A4pRnQ
https://science.km.edu.tw/api/pageview/team/1085?t=1617005652
https://science.km.edu.tw/api/pageview/team/1085?t=1617005652
https://science.km.edu.tw/api/pageview/team/1085?t=1617005652
https://zh.wikipedia.org/zh-tw/%E6%B0%B4%E9%8C%98%E4%BD%9C%E7%94%A8
https://zh.wikipedia.org/zh-tw/%E6%B0%B4%E9%8C%98%E4%BD%9C%E7%94%A8
https://arxiv.org/abs/physics/0611133
https://link.springer.com/article/10.1007/s00253-002-0971-2#auth-_J_-Wu-A1
https://link.springer.com/article/10.1007/s00253-002-0971-2
https://link.springer.com/article/10.1007/s00253-002-0971-2


【評語】030318 

本研究探討被子植物在受到傷害時發出的超聲波，並分析不同維管束

數量和比例對超聲波頻率和次數的影響。結果顯示，植物在受傷後會

發出 60 分貝以上的超聲波，且維管束的數量和比例影響超聲波的頻

率和次數。 

審查意見 

1. 研究主題 

探討被子植物在受到傷害時的超聲波反應，對理解植物的應激反應和

內部機制具有意義。 

2. 創意、學術或實用價值 

此研究為以 Itzhak Khait 和 Ohad Lewin-Epstein(2023)為基礎，

探討被子植物在受到傷害時的超聲波反應，將維管束結構與超聲波頻

率和次數進行關聯分析。 

3. 科學方法之適切性 

研究使用自製超聲波接收器進行實驗，結合顯微鏡觀察和數據分析進

行研究與紀錄。實驗設計尚稱合理，可再增加物種數、樣本數和重複

次數，以更多重複實驗來驗證結果的穩定性。 
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研究結果

實驗⼀、各種類植物維管束數量及⾯積⽐例之分析

研究過程及⽅法

研究⽬的

研究設備器材

前⾔

電阻 10KΩ

超聲波感測器TCT40

鋁質電解電容
運算放⼤器OP350PA

電阻 1KΩ

超聲波感測器TCT40

運算放⼤器OPA350PA

鋁質電解電容

電阻  1KΩ
電阻  10KΩ

電阻 200KΩ
電阻 3.9KΩ

超聲波接收器

前置實驗、裝置測試

三、隔⾳箱的隔⾳效果

結果分析：隔⾳箱可以有效的隔絕部分環境雜⾳。

實驗裝置外觀圖實驗植物

植物類型
植物名稱

莖切⽚照⽚
維管束平均數量(個)

維管束⾯積⽐例

單⼦葉植物
⽟⽶ 狗⽛根 ⿏尾粟 鯽⿂草 吊⽵梅

94 13 44 20 28
10.50%22.88%28.32% 38.75%26.89%

植物類型

35.89% 26.9% 10.4%

雙⼦葉植物植物類型
植物名稱

莖切⽚照⽚
番茄 繁星花

34 16 8 20
20.10%維管束⾯積⽐例

⼤花咸豐草

維管束平均數量(個)

美洲假蓬 ⾺拉巴栗

86
23.56%

四、超聲波數據收集1.將實驗植物放⼊⾃製隔⾳箱2.測量溫度(相差1度以內)、⾼度等基本資料3.開始收⾳4.5分鐘後進⾏植物莖的切斷5.⽤電腦收集⾳頻、次數、間隔時間等數據6.⽤螺旋測微器測量植物莖的直徑 (mm)7.將莖橫切出透光薄⽚，⽤顯微鏡觀察拍攝維管束排列⽅式8.⽤ ImageJ計算維管束⾯積和莖的截⾯積9.計算植物的維管束⽐例      維管束⾯積÷莖總截⾯積×100%= 維管束⽐例%

⼆、超聲波接收器的準確度

⼀、製作接收器1.利⽤超⾳波感測器、運算放⼤器等製作PCB板2.與Arduino連接電腦，進⾏偵測超聲波的程式編寫
⼆、感測器測試            數位信號產⽣器連接喇叭後發出特定的超聲波         (1)2V、4V；(2)30kHz、40kHz、50kHz         以確定感測器能正常運作
三、測量隔⾳箱的隔⾳效果1.使⽤⼿機app分⾙計測量隔⾳箱內和隔⾳箱外⾳量⼤⼩數值2.進⾏數據⽐較，分析實驗裝置的隔⾳效果

隔⾳棉

植物

超聲波感測器

維�束

�截⾯積

⼀、超聲波接收器可接收的⾳量範圍

結果分析：⾃製超聲波接收器可接收的超聲波⾳量範圍在60分⾙以上。

五、數據統計分析⽅法1.相關性分析(R)：R值代表相關程度之⾼低，在正負0.3之間稱為低度相關；在正負0.3⾄0.6之間 稱為中度相關；⽽在正負0.6⾄0.9之間則稱為⾼度相關；若是R值為正負 1，表⽰完全相關。 2.T檢定:(P)T檢定中，P值<0.05表⽰兩組間有顯著差異

⽣物課時，⽼師曾提過⼀篇研究，內容是植物在壓⼒下會發出尖叫聲，但這個尖叫聲是⼈⽿聽不到的超聲波，植物的聲⾳透過空氣傳播並提供訊息，這顛覆我們⼀般對植物安靜的認知。所以我們想確認植物是不是真的會發出超聲波？不同種類的植物發出的聲⾳狀況是否⼀樣？

(⼀)各種類植物維管束數量及⾯積⽐例之分析(⼆)⽐較單⼦葉植物與雙⼦葉植物在受傷狀態下發出的超聲波差異(三)在受傷狀態下，探討維管束數量和植物發出超聲波的關係(四)在受傷狀態下，探討維管束在莖內⽐例和植物發出超聲波的關係(五)在有無照光下，植物受到傷害所發出的超聲波差異

結果分析：⾃製接收器的數據與實際的超聲波頻率相符合。

單⼦葉植物 雙⼦葉植物 實驗裝置內部圖



實驗⼆、⽐較單、雙⼦葉植物在受傷狀態下發出的超聲波差異

結果分析：單、雙⼦葉植物的發聲⽐例無顯著差異。

⽟⽶ ⿏尾粟 鯽⿂草 狗⽛根 吊⽵梅

單⼦葉植物的實驗發聲⽐例

發聲
⽐例

(%)

番茄 繁星花 美洲假蓬 ⼤花咸豐草 ⾺拉巴栗

雙⼦葉植物的實驗發聲⽐例

發聲
⽐例

(%)

p=0.09�顯��異

⼀、不同植物有發聲的⽐例 ⼆、不同植物發出的超聲波頻率
不同植物發出�個超�波的��

結果分析：單、雙⼦葉植物的平均頻率無顯著差異。
p=0.14�顯��異

不同植物的發聲頻率比較

單、雙子葉植物的發聲頻率比較

三、不同植物發出多個超聲波的⽐例

結果分析：單、雙⼦葉植物發出多個超聲波的⽐例無顯著差異。
番茄起始發聲時間

起
始

發
聲

時
間

(秒
)

實驗次數(次)

玉米起始發聲時間

實驗次數(次)

起
始

發
聲

時
間

(秒
)

p=0.46�顯��異

單、雙子葉植物的平均起始發聲時間

四、⽐較植物的起始發聲時間

討論：發現維管束的排列⽅式對超聲波產⽣並無影響，⽽不同植物的結果存在差異，推測與維管束管徑⼤⼩、密度、⽐例等因素有關。

結果分析：單、雙⼦葉植物的起始發聲時間無顯著差異。

實驗三、探討維管束數量和植物發出超聲波的關係
三、發聲時間與維管束數量⼆、發聲次數與維管束數量⼀、超聲波頻率與維管束數量

無相關 ⾼相關 中相關
討論：推測超聲波的產⽣與⽊質部的⽔分運輸有關，因此維管束數量多，發聲機率⾼。
實驗四、探討維管束⽐例和植物發出超聲波的關係

⼀、超聲波頻率與維管束⽐例 ⼆、發聲次數與維管束⽐例 三、發聲時間與維管束⽐例

⾼相關 低相關 低相關
討論：維管束⽐例越⾼，超聲波的頻率就越⾼，推測是維管束的結構密度會影響聲⾳頻率的⾼低。

不同植物的起始發聲時間

p=0.16�顯��異

單、雙子葉植物發出多個超聲波的比例



參考資料

結論

討論：1.由實驗5-1、5-3，推測在照光、氣孔打開、⽔分運輸較快時，發聲次數較多。2.由實驗5-2、5-4得知在照光、氣孔打開、⽔分運輸較快時，平均頻率反⽽⽐⿊暗組低，進⼀步分析收⾳的原始數據，發現照光與⿊暗組發出的⾳頻⼤多差異不⼤，但⿊暗組時有⾼頻聲⾳，因此拉⾼了平均的頻率。再分析所有實驗的數據，發現會有相同的現象。

頻率
(kH

z)

照光 ⿊暗
p=0.37�顯��異

頻率
(kH

z)

照光 ⿊暗
p=0.003�顯��異

無⾼頻聲⾳
⽟⽶照光頻率玉米照光頻率

發
聲

頻
率

(k
H

z)

較⾼頻聲⾳⽟⽶⿊暗頻率玉米黑暗頻率

發
聲

頻
率

(k
H

z)

發聲
時間

(秒)

照光 ⿊暗p=0.14�顯��異

發聲
時間

(秒)

p=0.17�顯��異照光 ⿊暗

實驗五、在有無照光下，植物受到傷害所發出的超聲波差異

 依照實驗結果得到以下結論：⼀、植物在受到切斷這類的物理傷害時，會間斷地發出         60分⾙以上的超聲波。⼆、單雙⼦葉維管束排列⽅式的差異不影響植物發聲，         但不同種類植物存在構造上的種間差異。
三、總維管束數量只影響發聲次數及聲量 (振幅) ⼤⼩。
四、維管束數量越多，發出超聲波的次數也越多。
五、維管束⽐例越⾼，發出的超聲波頻率也越⾼。
六、照光時的發聲次數較多、超聲波平均頻率較低;⿊暗
         時會發出少數⾼頻超聲波。
七、我們推論影響發聲的機制有:
         1.⽔錘效應(20~40kHz)、2.空氣柱振動(40kHz以上)

植物在物理傷害時的超聲波機制：(⼀)維管束遭受物理傷害時，管內流體被阻斷產⽣        ⽔錘效應，發出較低頻超聲波。(⼆)切斷⾯附近⽔分停留、溢出，造成持續⽔錘效應。(三)後續在壓⼒變化及⽔分運輸中斷的影響下，維管束        斷⾯端產⽣空氣柱，空氣柱震動產⽣駐波、發出        較⾼頻超聲波。(四)超聲波的最低頻率決定於空氣柱的⻑度，因此蒸散        速率與維管束的管徑皆會影響空氣柱的⻑度，進        ⽽影響超聲波的頻率與次數。 植物發聲原理⽰意圖

⼆、⽟⽶和繁星花在有無照光時的超聲波頻率

四、⽟⽶單次實驗中的發聲頻率概況分析

三、⽟⽶和繁星花在有無照光時的發聲時間

⼀、⽟⽶和繁星花在有無照光時的發聲次數

五、⿊暗中全部植物發聲頻率概況分析

結果分析：⽟⽶在照光時的發聲時間較短，繁星花則相反。

1.Itzhak Khait和Ohad Lewin-Epstein(2023),Sounds emitted by plants under stress are airborne andinformative,Cell,from:https://www.cell.com/cell/fulltext/S0092-8674%2823%2900262-32.T檢定，統計學知識⼊⼝網站，取⾃:https://www.jmp.com/zh_tw/statistics-knowledge-portal/t-test.html3.阿簡 (2007年9⽉1⽇)，以ImageJ測量葉⾯積，阿簡⽣物筆記，取⾃:https://a-chien.blogspot.com/2007/09/imagej_2149.html※本作品『莖聲尖叫‒探討被⼦植物在受到傷害時的超聲波差異』內容所有照⽚、圖⽚、圖表皆由作者⾃⾏拍攝、繪製。

結果分析：照光組頻率差異不⼤，⽽⿊暗組有超聲波的頻率遠⾼於其他超聲波。

結果分析：⽟⽶和繁星花的發聲頻率在照光時的發聲時間都較⿊暗時低。結果分析:⽟⽶和繁星花照光組的發聲總次數皆多於⿊暗組。

結果分析：植物發聲的頻率在40kHz以上的⽐例較低，⼤多在20~40kHz。

差異
維管束⽐例 維管束數量

超聲波頻率 發聲次數

植物發出超聲波

成因

⽔錘效應
低頻(撞擊) ⾼頻(駐波)

照光(蒸散快)

空氣柱

⿊暗(蒸散慢)

⽣物意義

警⽰周圍植物、改變細胞
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